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PowerPoint: Not Just for Presentations

PowerPoint is a multi-modal tool that is mostly used as a slide show to give others information.
Sometimes we have to come up with new and innovative ways to gets students involved and using
the computer is a great motivator. Teachers can create activities in PowerPoint and have students
manipulate the activities in design mode to make it their own. Students can present their activity to
their class in the slide show mode.

Here are some examples of what you can do with PowerPoint in design mode:
Build a Face:

1. Create afolder on your desktop or My Documents to save your
graphics in. (Right click on the desktop, select New and choose
Folder)

2. Use clipart from internet or Microsoft.com. (You can edit clipart

with Photoshop or some other graphic editing software.)

3. Open a blank PowerPoint document.

4. Select Design tab and choose a design that you would like for this activity. (Blank template)

5. Select Design tab and Page Setup.

6. Change the width to 25 and the height to 12, click ok.

7. Select the Home tab, in the Slides group, select Layout and choose Blank.

8. Select View tab, then Slide Master.

9. Delete all text boxes on slide.

10. Right click on slide and click Format Background.

11. Choose Fill, Solid fill, and color Blue. (or any color you choose.) Click Close.

12. Select Insert tab and Picture.

13. Locate the picture of the Wanted Poster and select Insert.

14. Insert picture of the head.

15. Select Insert tab, in the Text group, click the arrow under Text Box. Select Draw Text Box.

16. Click in the text box and type “Wanted”.

17. Click on the outside of the text box to select it. Select the Format tab, in the Shape Styles
group, choose a style you would like for the text box. The font color, size, etc. can also be
changed.

18. Select the text box. Clck to add title |

Correct text box selection Incorrect text box selection

19. Right click on the text box and select Copy.

20. Click off of the selected text box and right click and select Paste.

21. Double click inside of the text box to select the text. Replace “Wanted” with “Eyes”.

22. The text box is already copied so right click and select Paste and replace the text in each box
with “Nose”, “Mouth”, “Accessories”, and “Hair”.
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23. Position the text boxes to their final locations. (These can be
repositioned by opening the Slide Master.)

24. Click on the Slide Master tab and select Close.

25. Insert all the body part clipart. Resize and reposition clipart. (Place the

item on the head and adjust the size to fit the face.)

26. When the clipart is positioned, click on the Office button and hover over the Print menu and
select Print Preview.

27. The preview should be just the wanted poster. (See picture)

28. If it does not look like the picture, open the Slide Master and reposition
the graphics.

29. Save the presentation as a PowerPoint Template.

30. Click the Microsoft Office Button, hover over the Save As menu and

select Other Formats.

31. Type in the name for the Presentation.

32. In the Save as Type box, click the arrow and select PowerPoint Template. This saves the
presentation as a template that cannot be changed by the user. If the user clicks on the icon
for the PowerPoint, a new presentation will open. The original file will not be changed.
Don’t open from within PowerPoint. This is how the designer can change the template.

33. PowerPoint automatically changes the location of the file to be saved to the Templates
Folder. To change this, select the drop down arrow next to location and select where you
would like to save the file. (Easy access for the students.)
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Fantasy (Categorizing):

Open a blank PowerPoint document.

Select Design and choose a design that you would like for this activity (Blank template).
Select View and Slide Master.

Delete all slides except Flow Slide Master and Title Slide

Layout. . : 4
Delete all Text Boxes from the Title Slide Layout. é - -l.

Find all pictures that are fantasy.

P wnNPe

_ -y
On the Title Slide Layout select Insert and Text Box. 3
Type in “Find all pictures that are fantasy”. ,/ %
Edit font size, color and justification. i) 2

) ¢

L 0N o wm

-
Select Insert, Shapes and Basic Shapes — Oval. L=

10. Draw an Oval on the Title Slide Layout slide under the Text
Box.

11. Select Format and Shape Fill — select color of Oval.

12. Select Side Master and Close Master View.

13. Select Insert and Picture.

14. Find the pictures on your computer of the items that are fantasy and reality.

15. Insert each picture and resize and reposition on the outside of the Oval.

16. Save your PowerPoint as a template.
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Life Cycle of the Frog:

15.
16.
17.
18.
19.
20.
21.
22.
23.

Open a blank PowerPoint document.

Select Design and choose a design that you would like for this activity (Ripple design

template downloaded from Microsoft).

Select View and Slide Master.

Delete all slides except Flow Slide Master and Title Slide Layout.
Right click on Title Slide Layout slide and select copy.

Right click again and select paste.

On the first Title Slide Layout select Insert and Text Box.

Type in “Life Cycle of the Frog”.

Edit font size, color and justification.

. Select Insert and Picture.

. Locate picture of a frog on computer and select Insert.

. Resize and position picture in the middle of the slide.

. On the second Title Slide Layout select Home and Shapes.

. Click on Rectangle and draw vertical rectangle on the left side of the

slide.

Select Format and Shape Fill — select White.

Select Insert, Smart Art, Cycle and Text Cycle.

Reposition Text Cycle to the right side of the slide.

Select each Text Box and delete the word TEXT.

Select Side Master and Close Master View.

On the second Slide select Insert and Picture.

Find the pictures on your computer of the frog’s life cycle.

Insert each picture and resize and reposition in the rectangle box.
Save your PowerPoint as a template.

Life Cycle of the Frog
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Sentence Strip:

paint I . like

Open a blank PowerPoint document.
Select Design and choose a design that you would like for this
activity (Blank template).

Select View and Slide Master.

Delete all slides except Flow Slide Master and Title Slide Layout.

Delete all Text Boxes from the Title Slide Layout.

Select Slide Master and Page Setup.

Change the width to 10 inches and the height to 3 inches and select Ok.
Select Close Master View.

Delete all Text Boxes on slide.

. Select Home and then Line on the Drawing toolbar. Draw a straight line on the slide.

. With the line selected, select Format and choose a Shape Style (Thick Black Line).

. On the left hand side of your screen, right click on the slide and select Copy.

. Right click again and select Paste (repeat to until you have four slides).

. Click on the first slide. Select Insert and Text Box.

. Draw a Text Box and type “paint” (repeat steps 16 and 17 for: |, . (a period), like and to.
. Hold your Shift key down and click on each Text Box to select them all.

. Select Home and edit Font and Style of text.

. Select Format, Align and Align Top.

. Select Align and Distribute Horizontally.

. Select Shape Fill and White.

21.

Save your PowerPoint.

Changing the Text Boxes to Pictures so that students cannot edit the text and can easily click

and drag boxes:

© N U R WN R

10.
11.
12.
13.

Click on the boarder of the Text Box and right click.

Select Save As Picture.

Navigate to a location on your computer where you want to save the picture.
Name the file and select Save.

Repeat steps 1 — 4 until all Text Boxes are saved as pictures.

Delete all Text Boxes.

Select Insert and Picture.

Navigate to the place on your computer that you saved your picture and select Insert
(repeat steps 8 — 9 until you have all Text Box Pictures on your slide).
Reposition Text Box Pictures.

Hold your Shift key down and click on each Text Box Picture to select them all.
Select Format, Align and Align Top.

Select Align and Distribute Horizontally.

Save your PowerPoint as a template.
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Wetlands Math:

1. Open a blank PowerPoint document.
Select Design and choose a design that you would like for this
activity (Blank template).

3. Select View and Slide Master.
Delete all slides except Flow Slide Master and Title Slide

Wetlands Math

Layout.
Delete all Text Boxes from the Title Slide Layout.
Wetlands are home to many plants, insects,

Select Insert and Text Box. amphibians, fish, reptiles and mammals.
Lets create a wetland full of life.
Type in “Wetlands Math”.

Select Home and edit font and style of text.

W N W

Select Insert and Picture.

10. Navigate to the place on your computer that you saved your picture (wetlands) and select
Insert.

11. Position and resize the picture.

12. Select Insert and Text Box.

13. Type in “Wetlands are home to many plants, insects, amphibians, fish, reptiles and
mammals. Let’s create a wetland full of life.”

14. Select Home and edit font and style of text.

An alligator is a reptile. They live in

15 Add new S”de the wetlands. Place 1 alligatorin the

wetlands.

16. Delete any Text Boxes on slide.

17. Select Insert and Picture.

18. Navigate to the place on your computer that you saved your
picture (wetlands) and select Insert.

19. Position and resize the picture.

20. Select Insert and Text Box.

21. Type in “An alligator is a reptile. They live in the wetlands. Place 1 alligator in the
wetlands.”

22. Select Home and edit font and style of text.

23. Select Slide Master and Close Master View.

24. Select Insert and Picture.

25. Navigate to the place on your computer that you saved your picture (alligator) and select
Insert.

26. Position and resize the picture (repeat steps 24 — 26 until you have 2 alligators).

27. Repeat steps 15 — 26 to add additional pages.

28. Save your PowerPoint as a template.
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C-Says:

1. Create a folder on your desktop or My Documents to save your graphics in. (Right click on

the

desktop, select New and choose Folder)

2. Use clipart from internet or clipart from Microsoft.com or real pictures of things that begin

with C (or any other letter of the alphabet).

3. Open a blank PowerPoint document.

Select Design tab and choose a design that you would like for this activity. (Advantage is the

template used for the example and it is located on your CD.)

5. Thesslide that appears is the Title Slide. Select Home tab, in the Slides group, click on the

words New Slide (not the picture of the slide) to add the following slides to the

presentation.

a.
b.

1 —Section Header Slide
5 — Picture Above Caption Slide

6. Click on the Slide One.

a.

b
c.
d

Sm oo

~

© = 3

On the Insert tab, in the Media Clips group, click the arrow under Sound.

Select Record Sound. Record Sound
Name your file. Ex. Cat Name: | Recorded Sound

Total sound length: 0

» ] E

Press the Red Record button to record the word cat.
Press the Blue Square button to end the recording. Press

N =
[ o< |

oK

Cancel

the Blue Play button to hear the recording.
Press OK and a speaker will appear on the slide.
Right click on speaker and select change picture.

Locate the picture of the cat on the computer and select Insert.
Resize and position your picture in the colored box to the left of the
slide.

Repeat steps 6.a - h to insert sounds and pictures of the candy, car,
cake, and carrot on the remaining colored boxes.

Record another sound “C says”.

On the Sound Tools Option tab click Hide During Show box. (The speaker will remain on

your slide but will not show during presentation.)
Click in the Title Text Box to add “Cc says...” .

. The Subtitle Text Box can be deleted.

Click on Insert tab, Shapes, Action Buttons, Forward and Next.

The cursor will change to crosshairs. Left click, hold and drag the cursor to form a

button and release. (The button can be resized: Click on the button, Format tab and
change the width (.59) and height (1.06) settings located all the way to the right of the

ribbon.)

The Actions Setting dialog box will appear.
Select the Mouse Click tab.

In the Action On Click section, click Hyperlink.
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Select Next Slide from the drop down menu. (default)

Click OK.

Left click, hold and drag the button to the bottom right hand corner.
Click on Animations tab and click on the Transition Sounds drop down

< c &+ w

list and select “C says”. To advance the slide, check On Mouse Click.
7. Click on Slide Two.

a. Clickin the Title Text Box and type capital and lowercase C. Delete + ( C
the other text box.

b. Resize the text and position the textbox in the middle of the slide.

c. Repeat step 6.v to add sound during the transition.
8. Click on Slide Three.
a. Click on Slide One, right click on the cat. Select Copy from the popup menu.

b. Click on Slide Three, right click and select Paste from the popup menu.
c. Resize and position your picture on the left of the slide. o . C
d. Clickin the Title Text Box and type “Cat”. Delete the other text box. M @;@
e. Click on Insert tab, in the Text group, select Text Box.
f.  Click, hold and drag the left mouse button over the top colored box on Carrot

the right of the screen and release. -

g. Type a capital “C”". Font adjustments might be necessary.
h. Repeat text box on blue box using “c”.
i. Repeat step 6.v to add sound during the transition.
j.  Repeat steps for Slide Three using the other C pictures.
9. Finishing the Activity.
a. To add a Next Button to each slide, click on Slide One. Right click on the Next Button
and copy.
Click on Slide Two and click Paste on the Home tab.
Repeat for each slide.
Click on Slide One in the Slide Sorter Window. (Tiny slides on the left side)
Click Copy on the Home tab then Paste.
Click on new slide and drag it to the end of the slides.
Repeat these steps to copy Slide Two and move it to the end of the slides.

Sm 0 a0 o

Click on Slide Nine, right click on the Next Button and select Edit Hyperlink.

When the Actions Setting dialog box appears.
Select the Mouse Click tab.
In the Action On Click section, click Hyperlink.

—_ X

Select First Slide from the drop down menu.
. Click OK.
On the Slide Show tab, in the Set Up group, click Set Up Slide Show.
Under Show Type, click Browsed At A Kiosk (full screen). Slide will only advance when
the Next button is clicked.
p. Save the presentation as a PowerPoint Show.

© =2 3
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Click the Microsoft Office Button.

Click Save As.

Type in the name for the Presentation.

In the Save as Type box, click PowerPoint Show. This saves the presentation to always
open in Slide Show view.

&t »w - o
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